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1 OVERVIEW 

Web Viewer Demo is a simple website built on the Foxit PDF SDK for Web. This guide will introduce how 

to use the functions of Web Viewer Demo on desktop and mobile.  

It supports the following browsers: 

 Internet Explorer 10, 11 and Edge 

 Chrome 

 Firefox 

 Safari 

 Opera 

2 WEB VIEWER DEMO ON DESKTOP 

After installing Foxit PDF SDK for Web, you can access the Web Viewer Demo in your browser at 

http://{ip}:{port}/. If you have used the default settings. The default demo file will be loaded. 

2.1 Getting Started 

The Web Viewer Demo is provided for developers to learn how to call the SDK, and to show what the 

Foxit PDF SDK for Web can do. A good way to get up to speed in using Web Viewer demo is by 

familiarizing yourself with its workspace. 

This section will mainly introduce the following contents:  

 The workspace basics for Web Viewer Demo including toolbar, right-click contextual menu, 

navigation panels, and floating toolbar. 

 Open PDFs. 

 Save PDFs. 

 Import/Export Form Data. 

2.1.1 Toolbar 

The toolbar displays the File, Home, Organize, Edit, Comment, and Protect tabs with different 

commands. You can easily and quickly find the desired feature in the toolbar. 
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Toolbar under the Home Tab 

To show or hide all toolbars, please do the following: 

 To hide the toolbar, click the arrow  located on the lower-right corner of the ribbon.  

 To show the toolbar, choose a tab and click the pushpin icon located on the lower-right corner of 

the ribbon. 

2.1.2 Right-click Contextual Menu 

Web Viewer demo provides a list of feature options in the right-click contextual menu (See the following 

figures). 

Operation Description 

On the view Change the zoom level, navigate to the previous/next page, rotate page, 

print document, or find a keyword in the PDF document. 

On selected text Copy, Highlight, underline, strikeout, squiggle, replace and insert text. 

On annotation Delete, reply to or set properties (color) of the selected annotation. 

     

Right-click Contextual Menu 

2.1.3 Navigation Panels 

The buttons on the left side of the navigation pane provides easy access to various panels as follows: 
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Panel Name Description 

 
Bookmark View document bookmarks. 

 
Thumbnail View page thumbnails. 

 
Comments  

View document comments.  

Expand all comments individually or collapse all comments in the panel. You can also 

edit the text of a pop-up note 

(highlight/underline/strikeout/squiggle/pencil/note/line/arrow/rectangle/oval/stamp), 

reply or delete a comment from the list. 

 
Layers 

Control the display of PDF layers to show or hide related contents stored in a variable 

number of separate layers. 

 
Search 

Search text in the current document, and all instances will be listed after the search is 

finished.  

To open/close a navigation panel, click its button on the left side of the navigation pane. You can change 

the view area for the navigation pane, just drag its right border to adjust the width. 

2.1.4 Floating Toolbar 

Click Hand tool  under the Home tab, in this mode, move the cursor to the bottom of your browser, 

then you will see the floating toolbar as follows: 

The floating toolbar displays the common features, such as page turning, zooming, rotating, and page 

layout changing. 

 

Floating Toolbar 

To show the floating toolbar, click Hand tool  under the Home tab, in this mode, move the cursor to 

the bottom of your browser, then you will see it. If you move the cursor away, the floating toolbar will 

disappear. 
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2.1.5 Open PDFs 

You can open an online PDF file or open a PDF file from your local system by clicking Open button under 

the Home tab, or you can click File > Open File, and then choose a local PDF document or enter a URL. 

 

2.1.6 Save PDFs 

After modifying your PDF, you can save the changes to the original PDF by clicking File > Download 

which will download the modified PDF to your local host. 

 

2.1.7 Import/Export Form Data  

When working with a form, you can choose to import/export form data from/as FDF or XFDF.  

 To import form data, click the Import Form icon , navigate to where the desired file is, 

and press Open. 
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 To export form data, click the Export Form icon , choose To a XML file, To a FDF file or 

To a XFDF file, navigate to where you want to save the XML/FDF/XFDF file (e.g., your Document 

folder). 

Tip: You can import PDF form data from XML, FDF, or XFDF file or export form data to a XML, FDF, or XFDF file. 

2.2 View PDFs 

Web Viewer Demo provides a bunch of features for your journey of PDF reading.  

This section will mainly introduce the following contents:  

 Page through a document 

 View file properties 

 Search text 

 Adjust page view 

 Full screen mode 

2.2.1 Page through a Document 

Using the Mouse  

Middle Mouse Wheel 

 Point your cursor in the document. 

 Scroll your middle mouse wheel up and down to page through.  

Right Mouse Button  

 Right click on your mouse button and select options on the pop-up context menu. 

Using the Scroll Bar 

 Drag the vertical scrollbar on the right side to page through the document. 

 If part of the document is out of visibility, you can use the vertical and horizontal scrollbars to 

move the document. 

Using Hand Tool 

 Click Hand tool under the Home tab, hold the middle mouse button/wheel mouse button, 

and then move the mouse to scroll the pages. 

Using Keyboard 

 Press Up and Down arrow on your keyboard to page through the document.  
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Using Bookmark 

The Bookmark pane is located on the left Navigation Pane. 

 Click on the bookmark icon  to show the Bookmark panel. 

 Click on the plus (+) or minus (-) signs to expand or collapse the bookmarks contents.  

 Click on a bookmark to jump directly to a chapter or section in the document. 

 Click on left arrow to hide bookmark panel. 

 Drag the right border of the pane to resize the bookmark panel. 

 

Using Page Thumbnails 

The Page Thumbnails panel can be accessed on the left Navigation Pane.  

 Click on the thumbnail icon  to show the thumbnails panel.  

 Drag the vertical scrollbar or press down Up/Down arrow key to quickly browse page 

miniatures. 

 Click on the left arrow to hide the thumbnails panel. 

   

1 Thumbnails icon: click it to show page thumbnails 

panel.  

2 Left arrow: click it to hide thumbnails panel. 

 

1 Bookmark icon: click it to show bookmark panel.  

2 Left arrow: click it to hide bookmark panel. 
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2.2.2 View File Properties 

To view PDF file properties, click File > Properties on the top toolbar. The following properties image is 

an example of the default PDF file that Web Viewer Demo uses. 

 

 

2.2.3 Search Text 

You can search a word, a phrase or sentence. To quickly find text you are looking for one by one, do the 

following: 

 Click anywhere on the document pane, and then press Ctrl+F to show the quick search box.  

 Tap  to open the search panel. 

 In the search box, input the key word or phrase. 

 Set the search criteria. 

a) Whole words only -- limits the search to match only whole words. For example, if you 

search for the word Read, the word Reader will not be found. 

b) Case-Sensitive -- makes the search case-sensitive. For example, if you search for the word 

text, the words Text and TEXT will not be found. 

 Press Enter to jump to the first instance of the search term, which appears highlighted. You can 

continuous to press Enter to find the next result. 
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If you want to find all the search results at once, you can do as follows: 

 Move your cursor to the left Navigation pane, choose Search icon  to open the Search panel. 

 In the Search box, input the key word or phrase. 

 Set the search criteria. 

 Press Enter button, and then all occurrences will be listed in a tree view with highlight. This will 

allow you to quickly preview the context and jump to specific locations. 

    

2.2.4 Adjust Page View 

When viewing a PDF file, you will need to adjust the view of your PDF documents, such as the page 

magnification and the display of pages. 

 Zoom in/out the Page View 

Web Viewer Demo supports the zoom range from 50% - 600%. 

To zoom in/out the page view, you can do one of the following. 

Using Zoom button on the toolbar 

Click the Zoom button icon  under the Home tab, choose a zoom value you wish to use. You can also 

click on the zoom in/out icon to decrease/increase the view. 

1 Search icon: click to show the Search panel.  

2 Start search: input text, and press Enter button. 

3 Set search criteria: set the search criteria as desired. 

4 Search result list: List all search instances with page 

number at the heading of each occurrence. Drag the 

scroll bar to browse the instances list, click on the 

specific instance to jump to the destination.  
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Using Right-click contextual menu 

Right-click on the Document Pane (any location on a page of your PDF document) to show the right-click 

contextual menu, choose the Zoom In or Zoom Out options to decrease/increase the view. 

    

Using Floating toolbar 

Click Hand tool  under the Home tab, in this mode, move the cursor to the bottom of your browser, 

then you will see the floating toolbar as follows: 

 

Point your cursor to the Zoom Box, choose a zoom value you wish to use. You can also click on the zoom 

in/out icon to decrease/increase the view. 
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Note: Scroll down the drop down list, there are more values like Fit Width or Fit Page you can choose. 

 Resizing a Page to Fit the Window 

There are three types for you to choose: 

 Fit Page: Resize the page to fit entirely in the document pane. 

 Fit Width: Resize the page to fit the width of the window. Part of the page may be out of view. 

 Actual Size: Resize the page to its actual size.  

You can right-click the Document Pane, and choose the options as desired. 

 Adjust the Page Display 

Changing Page Orientation 

To change page orientation, you can do one of the following: 

 Right-click on the Document Pane to show the right-click contextual menu, choose Rotate Right 

option to rotate the pages. 

 

 Click Hand tool  under the Home tab, in this mode, move the cursor to the bottom of your 

browser to show the floating toolbar, and then choose rotate left icon  and rotate right icon  

to rotate the pages. 

 

Changing Page Layout 

To change page layout, Web Viewer Demo provides the single page and continuous page layouts. 

 Single Page: Displays one page in the document pane at a time. 
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 Continuous: Arranges the pages in the document pane in a continuous vertical column. 

Click Hand tool  under the Home tab, in this mode, move the cursor to the bottom of your browser 

to show the floating toolbar, and then choose Single Page icon  and Continuous icon  to set the 

page layout.  

2.2.5 Full Screen Mode 

In Full Screen mode, the Document Pane fills the entire screen, with Menu Bar, Toolbar, and Navigation 

Pane hidden behide. 

Click Hand tool  under the Home tab, in this mode, move the cursor to the bottom of your browser 

to show the floating toolbar, and then choose the icon  to start full screen mode. 

Press Esc to escape the full screen mode. 

2.3 Organize 

You can organize your pages through Web Viewer Demo, which includes rotating, moving, adding, and 

deleting pages. Click Origanize tab, you can see the supported features as follows: 

 

This section will mainly introduce the following contents:  

 Rotate pages 

 Move a page 

 Add a blank page 

 Delete pages 

2.3.1 Rotate Pages 

You can rotate all or selected pages in a document. 

To rotate one page, do the following: 
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 Select the page that you want to rotate. 

 Choose  or  to rotate the selected page. 

To rotate multiple pages, do the following: 

 Click Select Pages icon . 

 In the pop-up Select Pages dialog box, select the pages that you want to rotate and click OK. 

 Choose  or  to rotate the selected page. 

 

2.3.2 Move a Page 

Web Viewer Demo allows you to move a page within a PDF document. 

To move one page, select the page that you want to move, drag and drop the page to the new location. 

2.3.3 Add a Blank Page 

To add a blank page, you only need to click the Blank Page icon , and then a new blank page will be 

added to the end of the document. 

2.3.4 Delete Pages 

You can delete all or selected pages in a document. 

To delete one page, do the following: 

 Select the page that you want to delete. 

 Click  on the page or Click  under the Organize tab to delete the seleted page. 

 In the pop-up Delete Pages dialog box, click DELETE PAGES. 

To delete multiple pages, do the following: 

 Click Select Pages icon . 

 In the pop-up Select Pages dialog box, select the pages that you want to delete and click OK. 



13 

 

 Click  under the Organize tab to delete the seleted page. 

 In the pop-up Delete Pages dialog box, click DELETE PAGES. 

2.4 Edit 

Web Viewer Demo provides the editing features to edit text, add text object, and add images. Click Edit 

tab, you can see the features as follows: 

 

This section will mainly introduce the following contents:  

 Select and Copy Text 

 Edit text 

 Add new text object 

 Add an image 

 Edit path object 

 Add a path object 

 Show/hide PDF layers 

2.4.1 Select and Copy Text 

With Web Viewer Demo, you can select text and copy it to other applications. 

To select and copy text, choose the Select Text icon  under the Edit or Home tab, and do the 

following: 

1. Position your cursor to a desired place, click and drag your mouse to select what you want. 

2. Right click on the selection, and choose Copy in the pop-up contextual menu. 
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3. If your current browser doesn’t allow to copy directly, you will see a pop-up to let you continue the 

copy. Select the text in the pop-up window, press down Ctrl + C, or right click on the highlight and 

choose Copy. Then click CLOSE to exit the pop-up without copying. 

 

2.4.2 Edit Text 

You can edit texts in a paragraph like Microsoft Office Word as well as changing their font, font size and 

color. 

To edit texts in a paragraph, do the following: 

 Select the Edit Text icon . 

 Click on the desired paragraph and double-click to start editing. You can set the font, font size, and 

font style (including bold, italic, underline and color). 

 

2.4.3 Add New Text Object 

You can add or insert new text object into a PDF document.  

To add text object, do the following: 

 Select the Add Text icon . 

 Click on the location that you want to input the text, and type new text in the position where the 

cursor is blinking. You can also paste or delete the text you input. 

 You can choose the text font format, such as the font, font size, and font style (including bold, italic, 

underline and color). 
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2.4.4 Add an Image 

You can add an image into a PDF document.  

To add an image, do the following: 

 Locate the page where you want to insert the image in your document. 

 Select the Image icon . 

 Choose the target image file in the Open dialog box and click Open. 

 Click on the page to add the image, you can drag the handles of the four corners to resize the image, 

as well as drag and drop it to a new location. Right-click the added image, choose Action to pop up 

the Actions window. Select 'Go to a page view' or 'open a web link' to set the action as desired. 

 Then, you can click File > Download to save the changes. 

 

Note: From version 6.2, the added image will be kept as an annotation after saving, so that it can be 

editable when you open the saved PDF file in Web Viewer Demo or in other PDF Viewer/Editor. 

2.4.5 Add a Path Object  

You can insert four shapes of path object like Line, Rectangle, Round rectangle and Oval. 

To add a path object, do the following: 

 Locate the page where you want to insert the path in your document. 

 Choose one path you need, such as Line , Rectangle , Round rectangle  and Oval . 

 Drag the pointer to draw a straight line, rectangle, round rectangle, oval or circle as desired.  

 Drag the handlers of the corners or sides to resize the path object or set the properties such as line 

color, fill color, opacity and thickness if necessary. 

 Click outside the path when you are done to set the path. 
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2.4.6 Edit Path Object 

To edit path objects, select the Edit Path icon , then you can do the following: 

a) Highlight an editable path when mouse is hovering over it. 

Move the mouse on the page, the path object will be shown with a blue dotted box. 

b) Delete/move one or a group of selected path objects. 

Select the path object that you want to move, drag and drop it to the new location. 

Right-click the path object that you want to delete, choose Delete. 

Note: From 6.2 version, Web Viewer Demo supports moving path objects across pages. 

c) Send the above path object backward when there are more than one path objects overlaying. 

Right-click the path object that you want to send it backward, choose Send to back. 

d) Set the line color, fill color, opacity, and thickness for selected path objects. 

Right-click the path object that you want to set its appearance, change the line color, fill color, 

opacity and thickness as desired.   

e) View the coordinate information of the current path object on the page and the point where mouse 

is hovering through long-pressing the left mouse on a selected path object. 

Long-press the left mouse on a path object to view the cooridinate information of the selected path 

object, as well as the point where mouse is hovering. 

f) Press Esc to escape the current mode 
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2.4.7 Show/Hide PDF Layers 

A layer or as it is more formally known Optional Content Groups (OCG) is a dictionary representing 

a collection of graphics that can be made visible or invisible dynamically by users of viewer 

applications. In a PDF file, each layer may hold any portion of the document's objects, and layers 

may be made visible or invisible, showing or hiding their contained objects, in any combination. 

With Web Viewer Demo, you can control the display of PDF layers with the Layers panel. To show or 

hide PDF layers, click the layer icon  on the left Navigation pane to show the layer panel, and then do 

one of the following: 

 To hide a layer, uncheck the layer. 

 To show a hidden layer, click the empty box and a checkmark will appear. 

 

2.5 Comment 

Web Viewer demo provides rich annotating features with different functions for you to choose: Text 

Markup Tools, Pin tools, Typewriter Tools, Drawing Tools, Measure Tools and Stamp Tools. You can add 

different comments by selecting the annotation tools from the Comment tab. Most of annotations have 

1. A checkmark indicates a displayed layer 

2. Hidden layer 
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an adhesive popup window, some are shown up initially, and some are not. You can double click on an 

annotation to show or hide it.  

Click Comment tab, you can see the features as follows: 

 

This section will mainly introduce the following contents:  

 Text markup tools 

 Sticky notes 

 Typewriter tools 

 Drawing tools 

 Measure tools 

 Stamp 

 Sound 

 Change the appearance of the comments 

 Undo and Redo the last action 

 Managing comments 

2.5.1 Text Markup Tools 

You can use Text Markup tools to indicate where text should be edited or noticed. Text Markups do not 

change the actual text in the PDF. Instead, they indicate which text should be deleted, inserted, 

highlighted or underlined. Text Markup tools include Highlight, Squiggly, Underline, Strikeout, Replace, 

and Insert. 

Button Tool Name Description 

 Highlight Text 
To mark important passages of text with a fluorescent (usually) 

marker. 

 Strikeout Text 
To draw a line to cross out text, making others know the text is 

deleted. 

 Underline Text To draw a line under to indicate emphasis. 

 Squiggly Text To draw a squiggly line under. 

 Replace Text To draw a line to cross out text and provide a substitute for it. 
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 Insert Text 
A proofreading symbol (^) used to indicate where something is to 

be inserted in a line. 

To add a text markup comment, do the following:  

 Choose the Highlight , Strikeout , Squiggly , Underline , Insert   tools as desired. 

 Click and drag from the beginning of the text you want to mark up. 

 Type your comments in the connecting pop-up box. If the pop-up note is not initially shown, double 

click on the markup to open it. 

 Press Esc to escape the current mode.  

 

For Highlight annotation, from version 6.1, Web Viewer Demo supports two new features: 

 Support to edit the range of text highlighting without needing to delete the text highlighting and 

then re-draw it. Just drag the handlers of the two sides to edit the range of text highlighting. 

 

 Support to copy the highlighted text. Just right-click the highlighted text, and choose Copy Text. 

 

2.5.2 Sticky Notes 

The Sticky Note pins a note icon on where your mouse clicks on the document and place an adhesive 

small popup on one side so you can add comments.  
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To add a note comment, do the following: 

 Select the Sticky Note icon  on the toolbar under the Comment tab. 

 Click on the page where you would like to add a note. Once clicked, a yellow note icon appears and 

a popup window comes out on one side of your page.   

 Double click on the connecting pop window to write notes.  

 

2.5.3 Typewriter Tools 

The Typewriter tools includes Typerwriter, Callout, and Textbox. 

 Typewriter 

To add comments with typewriter, do the following: 

 Choose Typewriter icon  on the toolbar under Comment tab. 

 Click on a page where you would wish to add text. 

 Type your comments. 

 Press Esc to escape the current mode. 

 

 Callout 

To add comments with callout, do the following: 

 Choose Callout icon  on the toolbar under Comment tab.  

 Click on a page where you would wish to add text. 

 Type your comments. 
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 Press Esc to escape the current mode. 

 

 Textbox 

To add comments with textbox, do the following: 

 Choose Textbox icon  on the toolbar under Comment tab.  

 Click on a page where you would wish to add text. 

 Type your comments. 

 Press Esc to escape the current mode. 

 

2.5.4 Drawing Tools 

Web Viewer Demo offers you tools to create types of shapes like Rectangle, Oval, Polygon, Polyline, 

Line, Arrow, Cloud and Pencil.  With one of the tools selected, you can click to draw a desired shape, and 

make comments on the adhesive popup. And it provides Eraser tool to erase the pencil drawing. 

Button Tool Name Description 

 Rectangle 
To draw a four-sided plane figure with four right angles. Press Shift 

key to draw a square. 

 Oval To draw an oval shape or a circle with pressing Shift key. 

 Polygon 
To draw a closed plane figure bounded by three or more line 

segments. 

 Polyline To draw an open plane figure with three or more line segments. 
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 Arrow 
To draw something, such as a directional symbol, that is similar to 

an arrow in form or function. 

 Line To mark with a line. 

 Cloudy To draw cloudy shapes. 

 Pencil To draw free-form shapes. 

 Eraser To eraser the pencil drawing. 

 Highlight Area 
To mark important area as a means of memory retention or for 

later reference. 

To add a drawing markup comment, do the following: 

 Choose the shape annotation icon on the toolbar under the Comment tab. 

 Click and drag to make a shape you want to mark up. For Pencil drawing, you can click the Eraser 

tool  to erase it, just dragging the pointer over the drawing area you want to erase.  

 Type your comments in the connecting popup. If the popup is not initially shown, double click on the 

shape to open it.  

 Press Esc to escape the current mode. 

 

2.5.5 Measure Tools 

Web Viewer Demo supports distance tool to measure object height and length.  

To measure the distance between two points, do the following: 

 Select the Distance tool icon  on the toolbar.  

 Once selected, the horizontal and vertical ruler comes out, and the Distance Measurement window 

appears on the right lower side of the page, where you can change Scale and distance information. 
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 Click to draw the distance line. Click the first point, move the pointer to the second point, and click 

again. The measurements will appear on the page. 

Note: During measuring a distance, you can click to finish or press Esc to cancel, or right click and choose 

Complete Measurement or Cancel Measurement. 

 

2.5.6 Stamp 

With Stamp features, you can apply standard, dynamic, and custom stamps to your document. Web 

Viewer demo supports image stamps with various image formats (bmp, jpg, jpeg, png, svg (with pdf)), 

and svg only supports HTTP format. Stamping PDF files is a very useful feature especially when you need 

to give reviewers some advices about the document's status or sensitivity. 

Stamp a PDF 

You can choose from a list of predefined stamps, or create custom stamps before stamping a PDF. All 

the stamps that you import or create are listed in the drop-down menu of the Stamp command. 

To apply a stamp, do the following: 

 Click the Stamp tool icon  on the toolbar under the Comment tab, and choose a stamp from the 

menu. 

 Click on the position where you want to place the stamp. 

 Press Esc to escape the current mode. 
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Note: From version 6.2, the added stamp will be kept as an annotation after saving, so that it can be 

editable when you open the saved PDF file in Web Viewer Demo or in other PDF Viewer/Editor. 

Create a custom stamp 

To create a custom stamp, do the following: 

 Click the Create icon  on the toolbar under the Comment tab, and choose Create custom stamp. 

 In the pop-up dialog box, click Browse and choose an image file. 

 Type a new category name or choose a category from drop-down menu, name the stamp, optionally 

set the width and height, and then click OK. 

 

Note: The created stamp will be listed in the drop-down menu of the Stamp command. 

Manage a stamp 

To manage a stamp, do the following: 

 Click the Create icon  on the toolbar under the Comment tab, and choose Manage custom 

stamp. 

 In the pop-up dialog box, click Add to create a stamp. Please refer to Create a custom stamp. 



25 

 

 Select a stamp, click Edit to edit the selectd stamp, such as changing category, stamp name, the 

width/height of image, or replacing the image. Please refer to Create a custom stamp. 

 Click Delete to remove the stamp. 

Note: Deleting a custom stamp category will delete all stamps that are subordinate to it. 

 

2.5.7 Sound 

Web Viewer Demo supports Sound tool to allow you to record your voice using a microphone. Please 

note that you should configure HTTPS protocol to allow your browser to access your microphone. 

To add sound annotation, do the following: 

 Click the Sound tool icon  on the toolbar under the Comment tab. 

 Click on the position where you want to place the sound. On the popup window, click  to start 

recording, click to finish recording, and click  to play the recorded audio, meanwhile you can 

click  to stop playing the audio at any time. Click OK. 

 The sound annotation will be added to the desired location. ` 

 Press Esc to escape the current mode. 
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Note: To play or stop playing the recorded audio, you can right-click the sound icon, and choose 'Play' or 

'Stop'. 

2.5.8 Change the Appearance of Comments 

You can change the color and appearances of comments or markups after you create them by right-

clicking the comment and choosing Properties. Also, you can set the new look as the default appearance 

for that tool. 

To change the appearance of the comments, do the following: 

 Select Hand tool or the intended annotation tool. 

 Right click on an annotation you would like to change properties, and choose Properties. 

 Make the changes you want. 

 Enable the option "Set current properties as default" will apply your current annotation style to all 

the afterward created annotations.  

 Click on Close to finish.  

Note: From version 6.2, it supports to change the appearance of Stamp annotation including color, 

opacity and rotation.  

2.5.9 Undo and Redo the last action 

Simply use the shoutcut "Ctrl+Z" to undo or use "Ctrl+Y" to redo the last action while adding comments. 

Note: Currently, the Eraser tool does not support undo and redo features. 

2.5.10 Managing Comments 

 Comments Panel 

All the annotations and comments you created on the document are listed in the Comments Panel. 

During navigating comments, you can use the Expand or Collapse icon to unfold or pack up all 

comments on each page. You can also reply or delete a comment. 



27 

 

 

Note: From 6.2 version, web Viewer demo supports editing annotation text in the Comment Panel. Just 

long press the text to edit it. 

 

 Show/Hide all Comments 

To show or hide all comments on the document, choose the Comment icon  on the toolbar 

under the Comment tab, choose Show all comments or Hide all comments options to show or hide all 

of the comments on the document. 

 

Note: The comments displayed on the Comments panel will be synchronously shown or hidden with the 

settings. 

1. Expand: Unfold all annotations on each page. 

2. Collapse: pack up all annotations on each page. 

3. Comments: List number of created comments. 

4. Left Arrow: Click to hide the annotation pane. 

5. Reply: Click to enter your comments. 

6. Delete: Click to delete the current comment, or cancel 

replying. 
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 Reply to Comments or Delete Comments 

To reply to comments or delete comments, you can do one of the following: 

1. Select the annotation that you want to reply or delete, right-click it and choose Reply to input the 

texts in the Reply fields, or choose Delete to delete it. 

2. Open the Comments Panel, click on a listed annotation you want to reply or delete, click Reply to 

input the texts in the Reply fields, or Click Delete to delete it.  

 Import/Export Comments Data 

This feature is especially useful for PDF reviewing. You can choose to import/export annotation data 

from/as FDF or XFDF.  

 To import annotation data, click the Import icon , choose Import FDF or Import XFDF, 

navigate to where the desired file is, and press Open. 

 To export annotation data, click the Export icon , choose Export FDF or Export XFDF, 

navigate to where you want to save the FDF or XFDF file (e.g., your Document folder). 

2.6 Protect 

The security feature of PDF gives you an exceptional control over your PDF files. To provide adequate 

protection for PDF’s contents, you can encrypt and secure PDF files to prevent unauthorized access, 

restrict sensitive operations, etc. 

Click Protect tab, you can see the features as follows: 

 

This section will mainly introduce the following contents:  

 Redaction 

 Ink Signature 

 Password Protection 
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2.6.1 Redaction 

The redaction feature allows you to remove sensitive information from your document prior to 

making it available to others. You are able to mark the text or graphics for Redaction first, and then 

apply the redaction. 

 Mark for Redaction 

To mark the text or graphics for redaction, do the following: 

 Select the Mark for Redaction icon  on the toolbar under Protect tab, and click OK on the pop-up 

dialog box. Then the Hand command changes into a Cross  automatically. 

 

 Hold the pointer over the text or image you want to redact and drag a rectangle around it.  

 The selected area will be in a red rectangle, and the rectangle will be filled with black color once 

moving the pointer to the selected area. 

 Set Redaction Properties 

You can set redaction properties, such as the Fill color, overlay text, font, font size, and so forth. Only 

before you apply the redaction can you set the properties. 

To set redaction properties, do the following: 

 Right-click the marked area and choose Properties and the Redaction Properties dialog box pops 

up.  

 Make the changes you want. 

 Enable the option "Set current properties as default" will apply your current settings to all the 

afterward redaction.  
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 Apply Redactions 

You need to apply the redactions after marking the text or graphics you want to redact. To apply 

the redaction, do the following: 

 Select the Apply Redactions  on the toolbar under the Protect tab. You can also do this by right-

clicking the marked content and choosing Apply or Apply All to redact either the selected content or 

all of the marked content in the document. 

 A dialog box pops up to give a warning message and asks if you are sure to apply the redaction or 

not. 

 Select OK after you have marked all content that you want to redact. 

2.6.2 Ink Signature 

The ink signature feature allows you to draw your own style signature and place it on your document. 

You can create a list of signatures for different use cases. 

To create an ink signature, do the following: 

 Select the Ink Signature  on the toolbar under the Protect tab. Then you can see the drawing 

board pop up on your screen. 

 Select a type of color dot and line weight dot, drag your mouse to draw a free signature. To re-draw, 

choose Eraser. 
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 Once completing, click on OK to add your calligraphy to the Signature List panel which is in the right 

side of the document pane. 

 

 Click the created signature in the Signature List panel, drag it to the location where you want to 

place the signature. Click  to add the ink signature to your document. 

 

To delete an ink signature, do the following: 
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 Click on the signature thumbnail that you do not want in the Signature list, and choose Delete 

button.  

 

2.6.3 Password Protection 

You can add a password to a PDF to limit access and restrict certain features, such as printing, copying 

and editing. 

There are two kinds of passwords that could be applied to a PDF file: a Document Open password and a 

Permissions password. When you set a Document Open password, anyone who tries to open the PDF 

must type in the password that you specified. When you set a Permissions password, anyone who wants 

to change the restrictions must type the Permissions password. Please note that if a PDF is secured with 

both types of passwords, it can be opened with either password, but only the Permissions password 

allows you to change the restrictions. 

Tip: There’s no way out to recover password from the PDF if you forgot it. To keep a backup copy of 

the PDF that is not password-protected is a good choice. 

Click the Password Protect icon  on the toolbar under the Protect tab. You can see the Password 

Protection dialog box pop up on your screen. 



33 

 

 

To add document open password, type a password in the following textbox: 

 

To add document restriction settings, check Add Document Restriction box, click OK on the pop-up 

warning dialog box, type a password in the textbox as below. 

 

Permission Specification 

Click the  button, the Permission settings dialog box will pop up as follows. In the 

Permission settings dialog box, check Restrict printing and editing of the document and its security 

settings and then select the options as needed. 

Print Allowed – specifies the level of printing which users are allowed for the PDF. 

A. Low resolution (150dpi) – allows users to print at no higher than 150-dpi resolution. 

B. High resolution – allows users to print with any resolution. 
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Changes Allowed – specifies the level of printing which users are allowed for the PDF. 

A. Inserting, deleting, and rotating pages – allows users to insert, delete, and rotate PDF pages. 

B. Filling in forms and signing existing signature fields – allows users to fill in forms and sign documents in 

existing signatures fields. 

C. Commenting, filling form and signing existing signature fields – allows users to add comments, fill in 

forms and sign documents in existing signatures fields. 

D. Any except extracting pages – allows users to do any operation but extract pages. 

Enable copying of text, images, and other content – allows users to copy content in PDFs. 

Enable text access for screen reader devices for the visually impaired – allows the visually impaired 

users to access text with screen reader devices. 

 

Encrypt Settings 

Encryption Algorithm – defines data transformations that cannot be easily reversed by unauthorized users. Web 

Viewer supports 128-bit AES, 256-bit AES and 128-bit ARC-FOUR. 

Don’t encrypt metadata – encrypts the contents of a PDF but still allow search engines access to the document 

metadata. 

 

After setting the permissions as desired, click OK on the Password Protection dialog box and save the 

document to make setting take effect. 
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2.7 Print 

You can print all pages of the current loaded PDF file or a range of pages with or without comments. The 

maximum allowed number of one print task are 100 pages.  

To print the current active file, do the following: 

 Click File > Print, and the Print Settings window appears where you can specify page ranges for the 

print task. By default the Current Page is checked. If the current document exceeds 100 pages, the 

first 100 pages will be printed. To print the left, do the print again.  

 

 Check Print Comments if you want comments to be included in the output file. 

 Click Next to proceed. 

 You can see a progress message appears as follows. The time length depends on the output page 

numbers you specified and file size.  You can click Cancel to abort the print. 

 

 Once the progress bar completes, the Print dialog box pops up by which you can set up available 

print settings.  
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 Click Print to start.  
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3 WEB VIEWER DEMO ON MOBILE 

When using Web Viewer Demo on a mobile device, you can access the Web Demo in your mobile 

browser at http://{ip}:{port}/mobile.html. If you have used the default settings. The default demo file 

will be loaded. 

3.1 Getting Started 

The features of Web Viewer Demo in Mobile are similar to the desktop version. 

This section will mainly introduce the following contents:  

 The workspace basics for Web Viewer Demo including toolbar, right-click contextual menu and 

navigation panels. 

 Open PDFs. 

 Save PDFs 

3.1.1 Toolbar 

The following picture shows the toolbars of Web Viewer Demo, in which the bottom toolbar is similar to 

the floating toolbar in desktop version. 
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3.1.2 Contextual Menu 

Web Viewer demo provides a list of feature options in the Contextual Menu (See the following figures). 

Operation Description 

On the view Change the zoom level, navigate to the previous/next page, rotate page, 

print document, or find a keyword in the PDF document. 

On selected text Copy, Highlight, underline, strikeout, squiggle, replace and insert text. 

On annotation Delete, reply to or set properties (color) of the selected annotation. 

     

Contextual Menu 

3.1.3 Navigation Panels 

Tap  on the top toolbar to show the navigation pane which provides easy acces to various panels. 

Panel Name Description 

 
Bookmark View document bookmarks. 

 
Thumbnail View page thumbnails. 

 
Comments  

View document comments.  

Expand all comments individually or collapse all comments in the panel. You can also 

edit the text of a pop-up note 

(highlight/underline/strikeout/squiggle/pencil/note/line/arrow/rectangle/oval/stamp), 

reply or delete a comment from the list. 

 
Layers 

Control the display of PDF layers to show or hide related contents stored in a variable 

number of separate layers. 



39 

 

 
Search 

Search text in the current document, and all instances will be listed after the search is 

finished.  

  

3.1.4 Open PDFs 

You can open an online PDF file or open a PDF file from your device. Tap  on the top toolbar, select 

Open > Open PDF files from your device/Open Online PDF File to choose a local PDF document or enter 

a URL. 
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3.1.5 Save PDFs 

After modifying your PDF, you can save the changes to the original PDF. Tap  on the top toolbar, 

choose Download to download the modified PDF to your device. 
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3.2 View PDFs 

Web Viewer Demo provides a bunch of features for your journey of PDF reading.  

This section will mainly introduce the following contents:  

 Page through a document 

 View file properties 

 Search text 

 Adjust page view 

 Full screen mode 

3.2.1 Page through a Document 

Using your Finger 

 Under Hand  mode, switch pages by swiping up or down with your finger on the screen. 

Using Bookmark 

Tap  on the top toolbar to show the navigation pane. 

 Tap the bookmark icon  to show the Bookmark panel. 

 Tap the plus (+) or minus (-) signs to expand or collapse the bookmarks contents.  

 Tap a bookmark to jump directly to a chapter or section in the document. 

 Tap the left arrow to hide bookmark panel. 

 

1 Bookmark icon: Tap it to show bookmark panel.  

2 Left arrow: Tap it to hide bookmark panel. 
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Using Page Thumbnails 

Tap  on the top toolbar to show the navigation pane. 

 Tap the thumbnail icon  to show the thumbnails panel.  

 Swipe up or down to quickly browse page miniatures. 

 Tap the left arrow to hide the thumbnails panel. 

 

3.2.2 View File Properties 

To view PDF file properties, tap  on the top toolbar, select Properties. The following properties image 

is an example of the default PDF file that Web Viewer Demo uses. 

1 Thumbnails icon: Tap it to show Page thumbnails panel.  

2 Left arrow: Tap it to hide thumbnails panel. 
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3.2.3 Search Text 

To quickly find text you are looking for one by one, tap  on the top toolbar, input the text, and tap 

return or go depending on your device, then it will jump to the first instance of the search term, which 

appears highlighted as follows: 

 

 

Continue to tap return or go to find the next result. 
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If you want to find all the search results at once, you can do as follows: 

 Tap  on the top toolbar to show the navigation pane. 

 Tap  to open the search panel. 

 In the search box, input the key word or phrase. 

 Set the search criteria. 

a) Whole words only -- limits the search to match only whole words. For example, if you 

search for the word Read, the word Reader will not be found. 

b) Case-Sensitive -- makes the search case-sensitive. For example, if you search for the word 

text, the words Text and TEXT will not be found. 

 Tap  next to the search box, and then all occurrences will be listed in a tree view with highlight. 

This will allow you to quickly preview the context and jump to specific locations. 

 

3.2.4 Adjust Page View 

When viewing a PDF file, you will need to adjust the view of your PDF documents, such as the page 

magnification and the display of pages. 

 Zoom in/out the Page View 

Web Viewer Demo supports the zoom range from 50% - 600%. 
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In previous version, Web Viewer Demo renders the zoomed content from the top-left corner of the 

page, but from version 6.1, it supports for rendering the zoomed content centered on the mouse. 

To zoom in/out the page view, you can do one of the following. 

Using two-finger 

Use two-finger pinch and stretch gesture or double tapping on the screen to zoom in or out a document. 

Using contextual menu 

Click Hand tool  under the Home tab, in this mode, tap and hold anywhere on the PDF document to 

show the contextual menu, and then choose the Zoom In or Zoom Out options to decrease/increase the 

view. 

 

 Resizing a Page to Fit the Window 

There are three types for you to choose: 

 Fit Page: Resize the page to fit entirely in the document pane. 

 Fit Width: Resize the page to fit the width of the window. Part of the page may be out of view. 

 Actual Size: Resize the page to its actual size.  

You can tap and hold anywhere on the PDF document to show the contextual menu, and choose the 

options as desired. 

 Adjust the Page Display 

Changing Page Orientation 

To change page orientation, you can do one of the following: 
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 Tap and hold anywhere on the PDF document to show the contextual menu, and choose Rotate 

Right option to rotate the pages. 

 

 Tap or  on the bottom toolbar to rotate the pages. 

 

Changing Page Layout 

To change page layout, We Viewer Demo provides the single page and continuous page layouts. 

 Single Page: Displays one page in the document pane at a time. 

 Continuous: Arranges the pages in the document pane in a continuous vertical column. 

Tap  or  on the bottom toolbar to set the page layout. 

3.2.5 Full Screen Mode 

In Full Screen mode, the Document Pane fills the entire screen, with Menu Bar, Toolbar, and Navigation 

Pane hidden behide. 

Tap  on the bottom toolbar to start full screen mode.  

Press Esc to escape the full screen mode. 

3.3 Page Organize 

You can organize your pages through Web Viewer Demo, which includes rotating, moving, adding, and 

deleting pages. Tap  on the top toolbar, and tap page organize icon , then you can see the 

supported features as follows:  
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This section will mainly introduce the following contents:  

 Rotate pages 

 Move a page 

 Add a blank page 

 Delete pages 

3.3.1 Rotate Pages 

You can rotate all or selected pages in a document. 

To rotate one page, do the following: 

 Tap the page that you want to rotate. 

 Choose or  to rotate the selected page. 

To rotate multiple pages, do the following: 

 Tap Select Pages icon . 

 In the pop-up Select Pages dialog box, select the pages that you want to rotate and click OK. 

 Choose or  to rotate the selected page. 
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3.3.2 Move a Page 

Web Viewer Demo allows you to move a page within a PDF document. 

To move one page, tap the page that you want to move, drag and drop the page to the new location. 

3.3.3 Add a Blank Page 

To add a blank page, you only need to tap the Blank Page icon , and then a new blank page will be 

added to the end of the document.  

3.3.4 Delete Pages 

You can delete all or selected pages in a document. 

To delete one page, do the following:  

 Tap the page that you want to delete. 

 Tap  on the page or tap  on the bottom of the page to delete the seleted page. 

 In the pop-up Delete Pages dialog box, click DELETE PAGES. 

To delete multiple pages, do the following: 

 Click Select Pages icon . 

 In the pop-up Select Pages dialog box, select the pages that you want to delete and click OK. 

 Tap  on the bottom of the page to delete the seleted page. 

 In the pop-up Delete Pages dialog box, click DELETE PAGES. 
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3.4 Edit 

Web Viewer Demo provides the editing features to edit text, add text object, and add images. Tap  

on the top toolbar, and tap Edit icon , then you can see the features as follows:  

 

This section will mainly introduce the following contents:  

 Select and Copy Text 

 Edit text 

 Add new text object 

 Add an image 

 Show/hide PDF layers 

3.4.1 Select and Copy Text 

With Web Viewer Demo, you can select text and copy it to other applications. 

To select and copy text, do the following: 

1. Tap and drag your finger to select what you want. 

2. After dragging, choose Copy in the pop-up contextual menu. 
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3. If your current browser doesn’t allow to copy directly, you will see a pop-up to let you continue the 

copy. Select the text in the pop-up window, and tap Copy. Tap ClOSE to exit the pop-up without 

copying. 

 

3.4.2 Edit text 

You can edit texts in a paragraph like Microsoft Office Word as well as changing their font, font size and 

color. 

To edit texts in a paragraph, do the following: 

 Tap the Edit Text icon .  

 Tap on the desired paragraph and double-tap to start editing. You can set the font, font size, and 

font style (including bold, italic, underline and color). 

 



51 

 

 

3.4.3 Add New Text Object 

You can add or insert new text object into a PDF document.  

To add text object, do the following: 

 Tap the Add Text icon .  

 Tap on the locaiton that you want to input text, and type new text in the position. You can also 

paste or delete the text you input. 

 You can choose the text font format, such as the font, font size, and font style (including bold, italic, 

underline and color). 

 

3.4.4 Add an Image 

You can add an image into a PDF document.  

To add an image, do the following: 

 Locate the page where you want to insert the image in your document. 

 Tap  to show more features about editing. Tap the Image icon .  

 Choose an image file from Cemera or Photo Library or iCloud Drive (for iOS device). 

 Tap on the page to add the image, you can drag the handles of the four corners to resize the image, 

as well as drag and drop it to a new location. Long press the added image, choose Action to pop up 

the Actions window. Select 'Go to a page view' or 'open a web link' to set the action as desired. 

 Then, you can tap  on the top toolbar, select Download to save the changes. 
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Note: From version 6.2, the added image will be kept as an annotation after saving, so that it can be 

editable when you open the saved PDF file in Web Viewer Demo or in other PDF Viewer/Editor. 

3.4.5 Show/Hide PDF Layers 

A layer or as it is more formally known Optional Content Groups (OCG) is a dictionary representing 

a collection of graphics that can be made visible or invisible dynamically by users of viewer 

applications. In a PDF file, each layer may hold any portion of the document's objects, and layers 

may be made visible or invisible, showing or hiding their contained objects, in any combination. 

With Web Viewer Demo, you can control the display of PDF layers with the Layers panel. To show or 

hide PDF layers, tap  on the top toolbar to show the navigation pane and then tap the layer icon  

to show the layer panel, then do one of the following: 

 To hide a layer, uncheck the layer. 

 To show a hidden layer, tap the empty box and a checkmark will appear. 

 

 

1. A checkmark indicates a displayed layer 

2. Hidden layer 
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3.5 Comment 

Web Viewer demo provides rich annotating features with different functions for you to choose: Text 

Markup Tools, Pin tools, Typewriter Tools, Drawing Tools, Measure Tools and Stamp Tools. You can add 

different comments by selecting the annotation tools. Tap  on the top toolbar, and tap Comment 

icon , then you can see the features as follows:  

 

This section will mainly introduce the following contents:  

 Text markup tools 

 Sticky notes 

 Typewriter tools 

 Drawing tools 

 Measure tools 

 Stamp 

 Change the appearance of the comments 

 Undo and Redo the last action 

 Managing comments 

3.5.1 Text Markup Tools 

You can use Text Markup tools to indicate where text should be edited or noticed. Text Markups do not 

change the actual text in the PDF. Instead, they indicate which text should be deleted, inserted, 
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highlighted or underlined. Text Markup tools include Highlight, Squiggly, Underline, Strikeout, Replace, 

and Insert. 

Button Tool Name Description 

 Highlight Text 
To mark important passages of text with a fluorescent (usually) 

marker. 

 Strikeout Text 
To draw a line to cross out text, making others know the text is 

deleted. 

 Underline Text To draw a line under to indicate emphasis. 

 Squiggly Text To draw a squiggly line under. 

 Replace Text To draw a line to cross out text and provide a substitute for it. 

 Insert Text 
A proofreading symbol (^) used to indicate where something is to 

be inserted in a line. 

To add a text markup comment, do the following: 

 Tap  on the bottom toolbar, choose the Highlight , Strikeout , Squiggly , Underline 

, Insert   tools as desired.  

 Tap and drag from the beginning of the text you want to mark up. 

 

For Highlight annotation, from version 6.1, Web Viewer Demo supports two new features: 

 Support to edit the range of text highlighting without needing to delete the text highlighting and 

then re-draw it. Just drag the handlers of the two sides to edit the range of text highlighting. 
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 Support to copy the highlighted text. Just right-click the highlighted text, and choose Copy Text. 

 

3.5.2 Drawing Tools 

Web Viewer Demo offers you tools to create types of shapes like Rectangle, Oval, Polygon, Polyline, 

Line, Arrow, Cloud and Pencil.  With one of the tools selected, you can draw a desired shape. And it 

provides Eraser tool to erase the pencil drawing. 

Button Tool Name Description 

 Rectangle 
To draw a four-sided plane figure with four right angles. Press Shift 

key to draw a square. 

 Oval To draw an oval shape or a circle with pressing Shift key. 

 Polygon 
To draw a closed plane figure bounded by three or more line 

segments. 

 Polyline To draw an open plane figure with three or more line segments. 

 Arrow 
To draw something, such as a directional symbol, that is similar to 

an arrow in form or function. 

 Line To mark with a line. 
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 Cloudy To draw cloudy shapes. 

 Pencil To draw free-form shapes. 

 Eraser To eraser the pencil drawing. 

 
Highlight Area 

To mark important area as a means of memory retention or for 

later reference. 

To add a drawing markup comment, do the following: 

 Tap  on the bottom toolbar, choose the shape annotation icon as desired. Or choose the Pencil 

tool . 

 Tap and drag to make a shape you want to mark up. For Pencil drawing, you can tap the Eraser tool

 to erase it, just dragging the pointer over the drawing area you want to erase.  

 

3.5.3 Typewriter Tools 

The Typewriter tools includes Typerwriter, Callout, and Textbox. 

 Typewriter 

To add comments with typewriter, do the following: 

 Tap  on the bottom toolbar, choose . 

 Tap on a page where you would wish to add text. 

 Type your comments. 
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 Callout 

To add comments with callout, do the following: 

 Tap  on the bottom toolbar, choose . 

  Tap on a page where you would wish to add text. 

 Type your comments. 

 

 Textbox 

To add comments with textbox, do the following: 

 Tap  on the bottom toolbar, choose . 

 Tap on a page where you would wish to add text. 

 Type your comments. 

 

3.5.4 Sticky Notes 

The Sticky Note pins a note icon on where you tap on the document and you can add comments. 

To add a note comment, do the following: 

 Tap the Sticky Notes icon  on the bottom toolbar. 

 Tap on the page where you would like to add a note. Once taped, a yellow note icon appears and a 

popup window comes out, write notes in the window, and tap OK. 
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3.5.5 Measure Tools 

Web Viewer Demo supports distance tool to measure object height and length.  

To measure the distance between two points, do the following: 

 Tap the Distance tool icon  on the bottom toolbar. 

 Once selected, the horizontal and vertical ruler comes out, and the Distance Measurement window 

appears on the right lower side of the page, where you can change Scale and distance information. 

 

 Draw a distance line. Tap and drag to draw a line, and then the measurements will appear on the 

page. 

 

3.5.6 Stamp 

With Stamp features, you can apply standard, dynamic stamps to your document. Stamping PDF files is a 

very useful feature especially when you need to give reviewers some advices about the document's 

status or sensitivity. 
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To add a standard or dynamic stamp, do the following: 

 Tap the Stamp tool icon  on the bottom toolbar, and choose a stamp from the menu.  

 Tap on the position where you want to place the stamp. 

 

Note: From version 6.2, the added stamp will be kept as an annotation after saving, so that it can be 

editable when you open the saved PDF file in Web Viewer Demo or in other PDF Viewer/Editor. 

3.5.7 Change the Appearance of Comments 

You can change the color and appearances of comments or markups after you create them. Tap and 

hold the comments and choose Properties. Also, you can set the new look as the default appearance for 

that tool. 

To change the appearance of the comments, do the following: 

 Tap the Hand tool icon , in this mode, tap on an annotation you would like to change properties, 

and choose Properties. 

 Make the changes you want. 

 Check the option "Set current properties as default" will apply your current annotation style to all 

the afterward created annotations.  

 Tap on Close to finish.  

Note: From version 6.2, it supports to change the appearance of Stamp annotation including color, 

opacity and rotation.  

3.5.8 Undo and Redo the last action 

Simply tap or  on the top left while adding comments. 

Note: Currently, the Eraser tool does not support undo and redo features. 

3.5.9 Managing Comments 

 Comments Panel 
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All the annotations and comments you created on the document are listed in the Comments Panel. 

During navigating comments, you can use the Expand or Collapse icon to unfold or pack up all 

comments on each page. You can also reply or delete a comment. 

 

Note: From 6.2 version, web Viewer demo supports editing annotation text in the Comment Panel. Just 

double-click the text to edit it. 

 

 Show/Hide all Comments 

To show or hide all comments on the document, tap  on the bottom toolbar, choose Show all 

comments or Hide all comments options to show or hide all of the comments on the document. 

1. Expand: Unfold all annotations on each page. 

2. Collapse: pack up all annotations on each page. 

3. Comments: List number of created comments. 

4. Left Arrow: Tap it to hide the annotation pane. 

5. Reply: Tap it to enter your comments. 

6. Delete: Tap it to delete the current comment, or cancel 

replying. 
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Note: The comments displayed on the Comments panel will be synchronously shown or hidden with the 

settings. 

 Reply to Comments or Delete Comments 

To reply to comments or delete comments, you can do one of the following: 

1. Tap and hold the annotation that you want to reply or delete, choose Reply to input the texts in the 

Reply fields, or choose Delete to delete it. 

2. Tap  on the top toolbar, and tap Comment icon  to show the Comments Panel. Tap on a 

listed annotation you want to reply or delete, choose Reply to input the texts in the Reply fields, or 

choose Delete to delete it.   

 Import/Export Comments Data 

This feature is especially useful for PDF reviewing. You can choose to import/export annotation data 

from/as FDF or XFDF.  

 To import annotation data, tap  and choose Import FDF or Import XFDF, and then select a FDF 

or XFDF file from your device. 

 To export annotation data, tap  and choose Export FDF or Export XFDF, and then a FDF or XFDF 

file will be generated, you can open it with other applications. 

3.6 Protect 

The security feature of PDF gives you an exceptional control over your PDF files. To provide adequate 

protection for PDF’s contents, you can encrypt and secure PDF files to prevent unauthorized access, 

restrict sensitive operations, etc. 

Tap  on the top toolbar, and tap Protect icon , then you can see the features as follows:  
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This section will mainly introduce the following contents:  

 Redaction 

 Ink Signature 

 Password Protection 

3.6.1 Redaction 

The redaction feature allows you to remove sensitive information from your document prior to 

making it available to others. You are able to mark the text or graphics for Redaction first, and then 

apply the redaction. 

 Mark for Redaction 

To mark the text or graphics for redaction, do the following: 

 Tap the Mark for Redaction icon  on the bottom toolbar, and tap OK on the pop-up dialog box.  
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 Tap and drag over the text or image you want to redact and drag a rectangle around it. 

 The selected area will be in a red rectangle. 

 Set Redaction Properties 

You can set redaction properties, such as the Fill color, overlay text, font, font size, and so forth. Only 

before you apply the redaction can you set the properties. 

To set redaction properties, do the following: 

 Tap and hold the marked area, choose Properties. Then the Redaction Properties dialog box pops 

up.  

 Make the changes you want. 

 Check the option "Set current properties as default" will apply your current settings to all the 

afterward redaction.  
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 Apply Redactions 

You need to apply the redactions after marking the text or graphics you want to redact. To apply 

the redaction, do the following: 

 Tap the Apply Redactions icon  on the bottom toolbar. You can also do this by tapping and 

holding the marked content and choosing Apply or Apply All to redact either the selected content or 

all of the marked content in the document. 

 A dialog box pops up to give a warning message and asks if you are sure to apply the redaction or 

not. 

 Select OK after you have marked all content that you want to redact. 

3.6.2 Ink Signature 

The ink signature feature allows you to draw your own style signature and place it on your document. 

You can create a list of signatures for different use cases. 

To create an ink signature, do the following: 

 Tap the Ink Signature icon  on the bottom toolbar. Then you can see the drawing board pop up 

on your screen.  

 Select a type of color dot and line weight dot, draw a free signature. To re-draw, choose Eraser. 
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 Once completing, tap on OK to add your calligraphy to the Signature List panel which is next to the 

bottom toolbar. 

 

 Tap the created signature in the Signature List panel, tap on the location where you want to place 

the signature. Tap  to add the ink signature to your document. 

 

To delete an ink signature, do the following: 

 Tap  on the signature thumbnail that you do not want in the Signature list.  
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3.6.3 Password Protection 

You can add a password to a PDF to limit access and restrict certain features, such as printing, copying 

and editing. 

There are two kinds of passwords that could be applied to a PDF file: a Document Open password and a 

Permissions password. When you set a Document Open password, anyone who tries to open the PDF 

must type in the password that you specified. When you set a Permissions password, anyone who wants 

to change the restrictions must type the Permissions password. Please note that if a PDF is secured with 

both types of passwords, it can be opened with either password, but only the Permissions password 

allows you to change the restrictions. 

Tip: There’s no way out to recover password from the PDF if you forgot it. To keep a backup copy of 

the PDF that is not password-protected is a good choice. 

Tap the Password Protect icon  on the bottom toolbar. You can see the Password Protection dialog 

box pop up on your screen.  
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To add document open password, type a password in the following textbox: 

 

To add document restriction settings, check Add Document Restriction box, tap OK on the pop-up 

warning dialog box, type a password in the textbox as below. 

 

Permission Specification 

Check the "Restrict printing and editing of the document and its security settings" option, and then 

select the options as needed. 

Print Allowed – specifies the level of printing which users are allowed for the PDF. 

A. Low resolution (150dpi) – allows users to print at no higher than 150-dpi resolution. 

B. High resolution – allows users to print with any resolution. 

Changes Allowed – specifies the level of printing which users are allowed for the PDF. 

A. Inserting, deleting, and rotating pages – allows users to insert, delete, and rotate PDF pages. 

B. Filling in forms and signing existing signature fields – allows users to fill in forms and sign documents in 

existing signatures fields. 

C. Commenting, filling form and signing existing signature fields – allows users to add comments, fill in 

forms and sign documents in existing signatures fields. 

D. Any except extracting pages – allows users to do any operation but extract pages. 

Enable copying of text, images, and other content – allows users to copy content in PDFs. 
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Enable text access for screen reader devices for the visually impaired – allows the visually impaired 

users to access text with screen reader devices. 

 

Encrypt Settings 

Encryption Algorithm – defines data transformations that cannot be easily reversed by unauthorized users. Web 

Viewer supports 128-bit AES, 256-bit AES and 128-bit ARC-FOUR. 

Don’t encrypt metadata – encrypts the contents of a PDF but still allow search engines access to the document 

metadata. 

 

After setting the permissions as desired, click OK on the Password Protection dialog box and save the 

document to make setting take effect. 

3.7 Print 

You can print all pages of the current loaded PDF file or a range of pages with or without comments. The 

maximum allowed number of one print task are 100 pages.  

To print the current active file, do the following: 

 Tap  on the top toolbar, select Print, and the Print Settings window appears where you can 

specify page ranges for the print task. By default the Current Page is checked. If the current 

document exceeds 100 pages, the first 100 pages will be printed. To print the left, do the print again.  
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 Check Print Comments if you want comments to be included in the output file. 

 Tap Next to proceed. 

 You can see a progress message appears as follows. The time length depends on the output page 

numbers you specified and file size.  You can tap Cancel to abort the print. 

 

 Once the progress bar completes, the Print dialog box pops up. Select a printer, set print copies, and 

tap Print to start. 
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4 CONTACT US 

Feel free to contact us should you need any information or have any problems with our products. We 

are always here, ready to serve you better. 

Foxit Support: 

http://www.foxitsoftware.com/support/ 

Sales Contact:  

Phone: 1-866-680-3668 

Email: sales@foxitsoftware.com 

Support & General: 

Phone: 1-866-MYFOXIT or 1-866-693-6948 

Email:  support@foxitsoftware.com 

 

 

mailto:support@foxitsoftware.com
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